
 
 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก 

 
 
 
 
 
 
 
 
 
 



 

ภาคผนวก ก 
 

คูมือการติดต้ังและขั้นตอนการทํางาน 
ระบบใหบรกิารวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ 

 
การติดต้ังระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ จะมี

สวนประกอบที่จําเปนในการติดต้ังเพื่อใชงานคือ 
1. โปรแกรมฐานขอมูล MySQL 4.0  
2. โปรแกรม SQLyog Enterprise MySQL GUI โปรแกรมจัดการฐานขอมูล MySQL  
ผูเขียนขอขามข้ันตอนการติดต้ังโปรแกรมฐานขอมูล MySQL 4.0 และการติดต้ังโปรแกรม 

SQLyog Enterprise MySQL GUI  สวนการติดต้ังระบบใหบริการวัสดุสารสนเทศของศูนยภาษา 
มหาวิทยาลัยราชภัฏอุตรดิตถสามารถทําตามข้ันตอนดังนี้ 
 
ก.1 การติดตัง้โครงสรางฐานขอมูล MyLCLAB 

1. ใสแผนซีดีรอมโปรแกรมท่ี ซีดีรอมไดรฟ (CD-ROM DRIVE) 
2. เปดโปรแกรม SQLyog Enterprise MySQL GUI เรียกใชโปรแกรมโดยการเขาไปท่ี 

START > All PROGRAMS > SQLyog Enterprise > SQLyog Enterprise 
3. จะปรากฏหนาตางเพื่อทําการติดตอกับฐานขอมูล MySQL 4.0 ดังรูป ก.1 
 

 
 
 
 
 
 
 
 
 

รูป ก.1 หนาตางเพื่อทําการติดตอกับฐานขอมูล MySQL 4.0 
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4. เม่ือกรอกขอมูลสําหรับติดตอกับโปรแกรมฐานขอมูล MySQL ครบ กด Connect เพื่อ
ทําการเขาสูระบบ จะเขาสูหนาจอการทํางานของโปรแกรม SQLyog MySQL GUI ดัง
รูป ก.2 

 
รูป ก.2 หนาจอการทํางานของโปรแกรม 

 
5. จากนั้นคลิกท่ีเมนู File > Open  หรือ กดคียลัด Ctrl+O ดงัรูป ก.3 

 
รูป ก.3 เมนู Open 
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6. ทําการเลือกไฟล MyLCLAB.sql จากไดเรกทอร่ี sql จากแผนซีดีโปรแกรมท่ี ซีดีรอม
ไดรฟ (CD-ROM DRIVE)  แลวคลิกปุม Open เพื่อทําการเปดไฟล MyLCLAB.sql ดัง
รูป ก.4 

 
 
 
 
 
 
 
 
 
 
 
 

รูป ก.4 เลือกไฟล MyLCLAB.sql จากไดเรกทอร่ี sql 
 

7. ท่ีหนาตาง Query ของโปรแกรม SQLyog  Enterprise MySQL GUI  จะปรากฎ script 
การสรางฐานขอมูล MyLCLAB ดังรูป ก.5 

 
รูป ก.5 หนาตาง Query โปรแกรม SQLyog Enterprise MySQL GUI 
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8. การประมวลผลชุดคําส่ังจากไฟลท่ีเปด โดยไปท่ีเมนู Edit > Excute Query > Excute 
All Queries หรือกดคียลัด Shift+F5 ดังรูป ก.6 
 

 
รูป ก.6 ประมวลผลชุดคําส่ัง 

 
9. หลังจากทําการประมวลผลชุดคําส่ังเสร็จแลว เลือกเมนู  Edit > Refresh Object 

Browser หรือ กดคียลัด F9  ดังรูป ก.7 

รูป ก.7 ประมวลผลชุดคําส่ัง 
 

10. โครงสรางฐานขอมูล MyLCLAB ท่ีติดต้ังเรียบรอยจะปรากฏข้ึน ดังรูป รูป ก.8 
 

รูป ก.8 ประมวลผลชุดคําส่ัง 
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ก.2 การติดตัง้ระบบใหบริการวัสดุสารสนเทศของศูนยภาษา 
1. ใสแผนซีดีรอมโปรแกรมท่ี ซีดีรอมไดรฟ (CD-ROM DRIVE) 
2. ในระบบท่ีซีดีรอมสามารถเปดไดโดยอัตโนมัติ จะปรากฏหนางตางการติดต้ัง

โปรแกรม LC-Material-2007 ดังรูป ก.10 สวนระบบที่ปดการทํางานแบบอัตโนมัติ
ของซิดีรอมใว ใหคลิก Start > Run พิมพ <CD Drive:>\AutorunCD (จากรูป ก.9 
ซีดีรอมไดรฟในระบบที่ติดต้ังเปนไดรฟ f:\ ท้ังนี้ไดรฟซีดีรอมอาจไมเหมือนกับ
ตัวอยาง ข้ึนอยูกับสภาพของระบบท่ีทําการติดต้ัง)  

 
รูป ก.9 เปดโปรแกรมติดต้ังดวยตนเอง 

 

 
รูป ก.10 หนาจอติดต้ังโปรแกรม 
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จากรูป ก.10 หนาจอตดิต้ังโปรแกรม ประกอบดวยรายการดังนี ้
รายการ ติดต้ัง LC-Material-2007 สําหรับติดต้ังระบบใหบริการวัสดสุารสนเทศ

ของศูนย ในสวนของผูดูแลระบบและเจาหนาท่ีศูนยภาษา 
รายการ ติดต้ัง LC-Student-2007 สําหรับติดต้ังระบบใหบริการวัสดุสารสนเทศ

ของศูนย ในสวนของผูดูแลระบบและเจาหนาท่ีศูนยภาษา 
รายการ จบการทํางาน สําหรับออกจากระบบติดต้ังโปรแกรม 

 
2.1 ข้ันตอนการติดต้ัง LC-Material-2007 

LC-Material-2007 หรือ ระบบใหบริการวัสดุสารสนเทศของศูนย มหาวิทยาลัย
ราชภัฏอุตรดิตถในสวนของผูดูแลระบบและเจาหนาท่ีศูนยภาษา มีข้ันตอนการติดต้ังระบบ
ดังนี้ 

1) เลือกรายการ ติดต้ัง LC-Material-2007 จะปรากฏหนาตางการติดต้ังระบบ
ใหบริการวัสดุสารสนเทศ ดังรูป ก.11 จากนั้นคลิก Next เพื่อทํารายการตอไป 

 
รูป ก.11 หนาจอติดต้ังโปรแกรม 

2) หนาตางแสดงไดเรคทอร่ีท่ีจะทําการติดต้ังระบบใหบริการวัสดุสารสนเทศ 
โดยคาเร่ิมตนของระบบจะทําการติดต้ังท่ี C:\Program Files\LC-Matearial-
2007 ดังรูป ก.12 จากนั้นคลิก Next เพื่อทํารายการตอไป 
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รูป ก.12 ไดเรคทอร่ีเร่ิมตนของระบบ 

 
3) จะปรากฏหนาตางสําหรับกําหนดชื่อกลุมของโปรแกรมท่ีจะปรากฏใน Start 

เมนู ดังรูป ก.13 จากนั้นคลิก Next เพื่อทํารายการตอไป 
 

 
รูป ก.13 หนาตางสําหรับกําหนดชื่อกลุมของโปรแกรม 
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4) คลิก Install เพื่อทําการติดต้ังระบบใหบริการวัสดุสารสนเทศ ดังรูป ก.14 

รูป ก.14 หนาตางแสดงรายการกอนการตดิต้ัง 
 

5) จะทําการติดต้ังระบบใหบริการวัสดุสารสนเทศ ดังรูป ก.15 หนาจอติดต้ัง
โปรแกรม 

รูป ก.15 หนาจอสถานะการติดต้ังโปรแกรม 
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6) เม่ือระบบทําการติดต้ังเสร็จแลวจะระบบจะทําการเปด config.ini ข้ึนมาเพื่อทํา
การกําหนดคาเร่ิมตนการติดตอฐานขอมูล 

ตัวอยางคาเร่ิมตนจากไฟล config.ini 
[Database Setup] 
Hostname=127.0.0.1 
Database=MyLCLAB 
User=root 
Password= 

 
Hostname หมายถึง ช่ือหรือหมายเลขเคร่ืองท่ีไดใหบริการโปรแกรม
ฐานขอมูล MySQL 
Database หมายถึง ช่ือฐานขอมูล ซ่ึงฐานขอมูลในท่ีนี้คือ MyLCLAB 
User  และ Password หมายถึง ช่ือและรหัสผานท่ีใชในการติดตอกับ
ฐานขอมูล ตามสิทธ์ิท่ีไดรับ 
 

2.2 ข้ันตอนการตดิต้ัง LC-Student-2007 
LC- Student -2007 หรือ ระบบใหบริการวัสดุสารสนเทศของศูนย มหาวิทยาลัย

ราชภัฏอุตรดิตถในสวนของผูใชบริการ มีลําดับข้ันตอนการติดต้ังและการกําหนดคา
เบ้ืองตนของระบบ คลายกันกับข้ันตอนการติดต้ัง LC-Material-2007 

 
ก.3 ขั้นตอนการทํางาน 
 จากการศึกษาระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ 
สามารถจําแนกข้ันตอนการทํางานของโปรแกรมไดดังนี้ 

 3.1 งานบริการโปรแกรมมัลติมีเดีย เปนการกําหนดใหผูใชบริการเขาใชโปรแกรม
มัลติมีเดียตามท่ีไดรับมอบหมายจากผูสอน โดยมีข้ันตอนดังรูป ก.16 โดยเร่ิมจากนําขอมูล
กลุมเรียนท่ีลงทะเบียนเรียนจากสํานักทะเบียน และอาจารยผูสอนสงขอมูลการเขาใช
โปรแกรมมัลติมีเดีย จากนั้นเจาหนาท่ีทําการบันทึกและกําหนดขอมูลการใชโปรแกรม
มัลติมีเดียของผูใชบริการ เม่ือผูใชบริการเขามาใชโปรแกรมมัลติมีเดียตามท่ีกําหนด ระบบ
จะทําการบันทึกขอมูลการเขาใชโปรแกรมมัลติมีเดียโดยมีข้ันตอนการทํางานดังรูป ดังรูป 
ก.17 
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รูป ก.16 ข้ันตอนกําหนดขอมูลการเขาใชโปรแกรมมัลติมีเดีย 

 

 
รูป ก.17 ข้ันตอนงานบริการโปรแกรมมัลติมีเดีย 

 
 3.2 งานลงทะเบียนวัสดุสารสนเทศ งานรับลงทะเบียนวัสดุสารสนเทศใหมและ
ปรับปรุงขอมูลวัสดุสารสนเทศ 

3.3 งานยืมวัสดุสารสนเทศ งานใหบริการยืมวัสดุสารสนเทศเพ่ือสนับสนุนการ
เรียนการสอน และการเรียนรูดวยตนเองมีข้ันตอนการทํางาน โดยหลักฐานผูใชบริการอาจ
เปนบัตรประจําตัวนักศึกษา บัตรประจําตัวหองสมุด บัตรอาจารย หรือบัตรเจาหนาท่ี หรือ
บัตรอ่ืนใดท่ีสามารถระบุตัวตนผูใชบริการได โดยมีข้ันตอนการทํางานดังรูป ก.18 
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รูป ก.18 ข้ันตอนงานยืมวัสดุสารสนเทศ 

 
 3.4 งานคืนวัสดุสารสนเทศ รับคืนวัสดุสารสนเทศของผูใชบริการ เพื่อใหวัสดุ
สารสนเทศของศูนยภาษาจะยังคงสามารถใหบริการแกผูมาใชบริการคนอ่ืนๆ ไดอยาง
ท่ัวถึงและมีประสิทธิภาพ และตรวจรับวัสดุสารสนเทศใหอยูในสภาพท่ีสามารถใชงานได 
และพรอมสําหรับการใหบริการยืมคร้ังตอไป โดยมีข้ันตอนการทํางานดังรูป ก.19 

 
รูป ก.19 ข้ันตอนงานคืนวัสดุสารสนเทศ  

 



 

ภาคผนวก ข 

 
คูมือการใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา 

มหาวิทยาลัยราชภัฏอุตรดิตถ  สําหรบัผูดูแลระบบ 
 
ระบบใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวทิยาลัยราชภัฏอุตรดิตถ ในสวน

ของผูดูแลระบบ พัฒนาข้ึนเพือ่เพิ่มขอมูลผูใชงานระบบใหบริการวัสดุสารสนเทศของศูนยของ
ภาษา สามารถทําตามข้ันตอนดังนี ้
 
ข.1 หนาจอหลักของการเขาใชระบบ 

1. ระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวน
ของผูดูแล สามารถเปดใชงานได โดยคลิกไปท่ี Start > All Programs > LC Material > 
LC Material 2007  

2. หนาจอหลักของการเขาใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัย
ราชภัฏอุตรดิตถ ในสวนของผูดูแลระบบจะปรากฏดังรูป ข.1 

 
รูป ข.1 หนาจอหลักระบบใหบริการวัสดสุารสนเทศของศูนยภาษา 

มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูดูละบบ 
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จากรูป ข.1 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้
  หมายเลข 1 รหัสผูใชงาน ปอนรหัสผูดูแลระบบเพื่อเขาสูระบบ 
  หมายเลข 2 รหัสผานผูใชงาน ปอนรหัสผานผูดูแลระบบเพ่ือเขาสูระบบ 

หมายเลข 3 ตกลง เพื่อยืนยนัการเขาใชงานระบบใหบริการวัสดุสารสนเทศของ
ศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูดูแลระบบ 

หมายเลข 4 ออกจากระบบ 
 
ข.2 หนาจอการทํางานระบบ 
 เม่ือผูดูแลระบบกรอกรหัสผูใชและรหัสผานถูกตอง และยืนยันการเขาใชระบบแลว ระบบ
ใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ โดยหนาจอการทํางาน
ในสวนของผูดูแลระบบสามารถ แสดงดังรูป ข.2  
 

 
รูป ข.2 หนาจอทํางานหลักของผูดูแลระบบ 

 
หนาจอทํางานหลักของผูดูแลระบบ ประกอบดวยเมนูการทํางานตางๆ ท่ีอํานวยความ

สะดวกและ สนับสนุนการทํางานของผูดูแลระบบ ดังรูป ข.3  
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รูป ข.3 เมนูการทํางานหนาจอทํางานหลักของผูดูแลระบบ 

 
จากรูป ข.3 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

  หมายเลข 1 รายช่ือผูใชงาน ประกอบดวยเมนูยอย แสดงดังรูป ข.4 

 
รูป ข.4 เมนูรายช่ือผูใชงาน 

 
จากรูป ข.4 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

• เมนูรายช่ือผูใชระบบ สําหรับแสดงขอมูลรายช่ือผูใชระบบ 

• เมนูเพิ่ม สําหรับเพิ่มขอมูลผูใชระบบ 

• เมนูลบ สําหรับลบขอมูลผูใชระบบ 

• เมนูแกไข สําหรับแกไขขอมูลผูใชระบบ 
 

หมายเลข 2 ประวัติการใชงาน แสดงขอมูลประวัติการเขาใชระบบของผูใชงาน  
หมายเลข 3 รายงาน จดัทํารายงาน ประกอบดวยเมนยูอย แสดงดังรูป ข.5 

 
รูป ข.5 เมนูรายงาน 

หมายเลข 4 ออกจากระบบ กลับสูหนาจอล็อกอินเขาระบบ 



 

ภาคผนวก ค 
 

คูมือการใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา 
มหาวิทยาลัยราชภัฏอุตรดิตถ สําหรับเจาหนาท่ี 

 
ระบบใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวทิยาลัยราชภัฏอุตรดิตถ ในสวน

ของผูใชงาน สามารถทําตามข้ันตอนดังนี ้
 
ค.1 หนาจอหลักของการเขาใชระบบ 

3. ระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวน
ของผูใชงาน สามารถเปดใชงานได โดยคลิกไปท่ี Start > All Programs > LC Material 
> LC Material 2007  

4. หนาจอหลักของการเขาใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัย
ราชภัฏอุตรดิตถ ในสวนของผูใชงานจะปรากฏดังรูป ค.1 

 
รูป ค.1 หนาจอหลักระบบใหบริการวัสดสุารสนเทศของศูนยภาษา 
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มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชงาน 
จากรูป ค.1 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

  หมายเลข 1 รหัสผูใชงาน ปอนรหัสผูใชงานเพ่ือเขาสูระบบ 
  หมายเลข 2 รหัสผานผูใชงาน ปอนรหัสผานใชงานเพื่อเขาสูระบบ 

หมายเลข 3 ตกลง เพื่อยืนยนัการเขาใชงานระบบใหบริการวัสดุสารสนเทศของ
ศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชงาน 

หมายเลข 4 ออกจากระบบ 
 
ค.2 หนาจอการทํางานระบบ 
 เม่ือผูใชงานกรอกรหัสผูใชและรหัสผานถูกตอง และยืนยันการเขาใชระบบแลว ระบบ
ใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ โดยหนาจอการทํางาน
ในสวนของผูใชงาน สามารถแสดงดังรูป ค.2  
 

 
รูป ค.2 หนาจอทํางานหลักของผูใชงาน 

หนาจอทํางานหลักของผูใชระบบ ประกอบดวยเมนูการทํางานตางๆ ท่ีอํานวยความสะดวก
และ สนับสนนุการทํางานของผูดูแลระบบ ดังรูป ค.3  
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รูป ค.3 เมนูหนาจอทํางานหลักของผูใชงาน 
 

จากรูป ค.3 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้
หมายเลข 1 ยืมคืนวัสดุสารสนเทศ เมนสํูาหรับลงช่ือผูใชบริการเขาใชศูนยภาษา 

ยืมคืนวัสดุสารสนเทศ ดังรูป ค.4 
หมายเลข 2 ผูใชบริการ เมนูสําหรับปรับปรุงขอมูลผูใชบริการ ปรับปรุงขอมูล

ประเภทผูใชบริการ ดังรูป ค.8 
หมายเลข 3 วสัดุสารสนเทศ เมนูสําหรับปรับปรุงขอมูลวัสดุสารสนเทศ ปรับปรุง

ประเภทวัสดุสารสนเทศ ปรับปรุงระเบียบการใชวัสดุสารสนเทศ ดังรูป ค.21 
หมายเลข 4 โปรแกรมมัลติมีเดีย เมนูสําหรับปรับปรุงขอมูลโปรแกรมมัลติมีเดีย 

ปรับปรุงขอมูลการใชโปรแกรมมัลติมีเดียของผูใชบริการ ดังรูป ค.28 
หมายเลข 5 ขอมูลสารสนเทศ เมนูสําหรับแสดงจํานวนผูเขาใชบริการศูนยภาษา 

สถิติจํานวนยืมวัสดุสารสนเทศ จํานวนยืมวัสดุสารสนเทศตามประเภทวัสดุสารสนเทศ 
จํานวนการเขาใชโปรแกรมมัลติมีเดีย สถิติเขาใชศูนยภาษา ดังรูป ค.31 

 เมนูสําหรับลงช่ือผูใชบริการเขาใชศูนยภาษา ยืมคืนวัสดสุารสนเทศ แสดงดังรูป ค.4 
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รูป ค.4 เมนูลงช่ือผูใชบริการเขาใชศูนยภาษา ยืมคืนวัสดสุารสนเทศ 

 
จากรูป ค.4 เมนูยืมคืนวัสดุสารสนเทศ สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

• จากรูป ค.4 เมนูลงช่ือเขาใชศูนยภาษา แสดงข้ันตอนทํางาน ดังรูป ค.5 

 
รูป ค.5 เมนูลงช่ือเขาใชศูนยภาษา 

 
จากรูป ค.5 เมนูลงช่ือเขาใชศูนยภาษา เม่ือคลิกท่ีปุมลงช่ือเขาใชศูนย ตาม

หมายเลข 1 จะปรากฏชองกรอกรหัสผูใชบริการตามหมายเลข 2 เม่ือกรอกรหัส
ผูใชบริการครบแลวคลิกปุมลงชื่อ ตามหมายเลข 3 ขอมูลผูใชบริการจะปรากฏท่ี
หนาจอทํางานบริเวณหมายเลข 4 

เมนูยืมคืนวัสดุสารสนเทศ ยังประกอบดวยเมนูจัดทํารายงาน ซ่ึงประกอบ
ไปดวยรายงานผูใชศูนย และสถิติการเขาใชศูนยภาษา 

o รายงานผูใชศูนยจะแสดงรายงานขอมูลรายช่ือผูลงช่ือเขาใชศูนยภาษา
รายวัน แสดงดังรูป ค.6   

o สถิติการเขาใชศูนยภาษาแสดงรายงานจํานวนผูเขาใชบริการตอวัน 
แสดงดังรูป ค.7 
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รูป ค.6 ตัวอยางรายงานขอมูลรายช่ือผูลงช่ือเขาใชศูนยภาษารายวนั 

 

 
รูป ค.7 ตัวอยางรายงานจํานวนผูเขาใชบริการตอวัน 

• จากรูป ค.4 เมนูรายการยืม เม่ือผูใชบริการตองการยืมวัสดุสารสนเทศ มี
ข้ันตอนการยมื ดังรูป ค.8 
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รูป ค.8 เมนูยืมวัสดุสารสนเทศ 

 
จากรูป ค.8 เมนูยืมวัสดุสารสนเทศ เม่ือคลิกท่ีปุมยืมวัสดุสารสนเทศ ตาม

หมายเลข 1 จะปรากฏชองกรอกรหัสผูใชบริการตามหมายเลข 2 เม่ือกรอกรหัส
ผูใชบริการครบแลวคลิกปุมลงคนหา ตามหมายเลข 3 ถารหัสผูใชบริการถูกตอง 
จะปรากฏขอมูลผูใชบริการดังรูป ค.9 

 
รูป ค.9 รหัสผูใชบริการถูกตอง 

 
ในกรณีท่ีหาขอมูลผูใชบริการไมพบ ระบบจะแจงเตือนไมพบรหัส

ผูใชบริการ จากน้ันกรอกรหัสวัสดุสารสนเทศท่ีตองการยืมลงในชองหมายเลข 4 
แลวกดเพิ่มรายการวัสดุสารสนเทศท่ียืมตามหมายเลข 5 จะปรากฏขอมูลวัสดุ
สารสนเทศบริเวณหมายเลข 6 ทําซํ้าหมายเลข 4 เม่ือมีการยืมวัสดุสารสนเทศหลาย
รายการเม่ือลงรายการวัสดุสารสนทเทศท่ีตองการยืมครบแลว กดบันทึกรายการยืม
เพื่อยืนยันการยืมวัสดุสารสนเทศ ตามรูป ค.9 หมายเลข 7 
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เมนูยืมวัสดุสารสนเทศ ประกอบดวยเมนูรายงานการยืม เมนูรายงานคาง
สง และใบแจงเตือนคางสงวัสดุสารสนเทศ  

o รายงานการยืมจะแสดงผลดังรูป ค.10  
o รายงานคางสง จะแสดงผลดงัรูป ค.11 
o ใบแจงเตือนคางสงวัสดุสารสนเทศ จะปรากฏขึ้นเม่ือมีการตรวจสอบ

พบวาผูใชบริการที่กําลังยืมวัสดุสารสนเทศมีรายการคางสงวัสดุ
สารสนเทศอยู เพื่อแจงเตือนคางสงวัสดุสารสนเทศ ดังรูป ค.12 
 

 

 
 

รูป ค.10 ตัวอยางรายงานการยืม 
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รูป ค.11 ตัวอยางรายงานคางสง 
 

 
รูป ค.12 ตัวอยางใบแจงเตือนคางสงวัสดุสารสนเทศ 
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• จากรูป ค.4 เมนูรายการคืนวสัดุสารสนเทศ สําหรับคืนวัสดุสารสนเทศท่ียืมไป
โดยผูใชบริการดังรูป ค.13 

 
รูป ค.13 หนาจอคืนวัสดุสารสนเทศ 

 
เมนูรายการคืนวัสดุสารสนเทศ ประกอบดวยรายงานรายการคืนวัสดุ

สารสนเทศ สําหรับแสดงรายการคืนวัสดสุารสนเทศ แสดงดังรูป ค.14 และรายงาน
คาปรับ สําหรับแสดงรายการคาปรับและสรุปยอดรวมคาปรับกรณีท่ีสงคืนวัสดุ
สารสนเทศลาชา แสดงดังรูป ค.15 

 
รูป ค.14 ตัวอยางรายงานการคืน 
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รูป ค.15 ตัวอยางรายงานคาปรับ 

 

• จากรูป ค.4 เมนูคูมือใชงาน สําหรับแสดงคูมือใชงาน ดงัรูป ค.16 

 
รูป ค.16 เมนูคูมือใชงานสําหรับเจาหนาท่ี 

 

• จากรูป ค.4 เมนูออกจากระบบ สําหรับออกจากระบบ 
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ผูใชบริการ เมนูสําหรับปรับปรุงขอมูลผูใชบริการ ปรับปรุงขอมูลประเภท
ผูใชบริการ ดังรูป ค.17 

 
รูป ค.17 เมนูผูใชบริการ 

จากรูป ค.17 เมนูผูใชบริการ สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี้ 

• เมนูผูใชบริการ เมนูสําหรับแสดงและปรับปรุงขอมูลผูใชบริการ ดังรูป ค.18 

 
รูป ค.18 เมนูแสดงและปรับปรุงขอมูลผูใชบริการ 

   เมนูผูใชบริการ ประกอบดวยรายงานขอมูลผูใชบริการ ดังรูป ค.19 

 
รูป ค.19 ตัวอยางรายงานขอมูลผูใชบริการ 
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• เมนูประเภทผูใชบริการ เมนสํูาหรับแสดงปรับปรุงขอมูลประเภทผูใชบริการ 
ดังรูป ค.20 

 
รูป ค.20 เมนูแสดงและปรับปรุงขอมูลประเภทผูใชบริการ 

 
เมนูประเภทผูใชบริการประกอบดวยรายงานขอมูลประเภทผูใชบริการดัง

รูป ค.21 

 
รูป ค.21 ตัวอยางรายงานขอมูลประเภทผูใชบริการ 

 
วัสดุสารสนเทศ เมนูสําหรับปรับปรุงขอมูลวัสดุสารสนเทศ ปรับปรุงประเภทวัสดุ

สารสนเทศ ปรับปรุงระเบียบการใชวัสดุสารสนเทศ ดังรูป ค.22 

 
รูป ค.22 เมนูวสัดุสารสนเทศ 
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จากรูป ค.22 เมนูวัสดุสารสนเทศสามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

• เมนูขอมูลวัสดุสารสนเทศ เมนูสําหรับแสดงและปรับปรุงขอมูลวัสดุ
สารสนเทศ ดังรูป ค.23 

 
รูป ค.23 เมนูแสดงและปรับปรุงขอมูลวัสดุสารสนเทศ 

 
เมนูขอมูลวัสดุสารสนเทศ ประกอบดวยรายงานขอมูลวสัดุสารสนเทศ ดัง

รูป ค.24 

 
รูป ค.24 ตัวอยางขอมูลขอมูลวัสดุสารสนเทศ 
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• เมนูประเภทวสัดุสารสนเทศ เมนูสําหรับแสดงและปรับปรุงขอมูลประเภท
วัสดุสารสนเทศ ดังรูป ค.25 

 
รูป ค.25 เมนูแสดงและปรับปรุงประเภทวสัดุสารสนเทศ 

เมนูประเภทวสัดุสารสนเทศ ประกอบดวยรายงานประเภทขอมูลวัสดุ
สารสนเทศ ดังรูป ค.26  

 
รูป ค.26 ตัวอยางรายงานประเภทขอมูลวัสดสุารสนเทศ 
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• เมนูระเบียบการใชวัสดุสารสนเทศ เมนูสําหรับแสดงและปรับปรุงขอมูล
ระเบียบการใชวัสดุสารสนเทศ ดังรูป ค.27 

 
รูป ค.27 เมนูแสดงและปรับปรุงประเภทวสัดุสารสนเทศ 

    
เมนูระเบียบการใชวัสดุสารสนเทศ ประกอบดวยรายงานระเบียบการใช

วัสดุสารสนเทศ ดังรูป ค.28 

 
รูป ค.28 ตัวอยางรายงานระเบียบการใชวัสดุสารสนเทศ 



 94 

โปรแกรมมัลติมีเดีย เมนูสําหรับปรับปรุงขอมูลโปรแกรมมัลติมีเดีย ปรับปรุงขอมูลการใช
โปรแกรมมัลติมีเดียของผูใชบริการ ดังรูป ค.29 

 
รูป ค.29 เมนูโปรแกรมมัลติมีเดีย 

จากรูป ค.29 เมนูโปรแกรมมัลติมีเดียสามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

• เมนูขอมูลโปรแกรมมัลติมีเดยี เมนูสําหรับแสดงและปรับปรุงขอมูล
โปรแกรมมัลติมีเดีย ดังรูป ค.30 

 
รูป ค.30 เมนูปรับปรุงขอมูลโปรแกรมมัลติมีเดีย 

 

• เมนูขอมูลการใชโปรแกรมมัลติมีเดีย เมนูสําหรับแสดงขอมูลการเขาใช
โปรแกรมมัลติมีเดียดังรูป ค.31 ปรับปรุงขอมูลการใชโปรแกรมมัลติมีเดีย ดัง
รูป ค.32 และ เมนูคนหาผูใชบริการที่ไดกําหนดการเขาใชโปรแกรมมัลติมีเดีย 
ดังรูป ค.33 
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รูป ค.31 เมนูแสดงขอมูลการใชโปรแกรมมัลติมีเดีย 

 

 
รูป ค.32 เมนูแสดงปรับปรุงขอมูลการใชโปรแกรมมัลติมีเดีย 

 

 
รูป ค.33 เมนูคนหาผูใชบริการท่ีไดกําหนดการเขาใชโปรแกรมมัลติมีเดยี 
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เมนูขอมูลสารสนเทศ ประกอบดวยเมนูจัดทํารายงานสําหรับอาจารย ผูอํานวยการ ดังรูป 
ค.34 และรายงานขอมูลการเขาใชโปรแกรมมัลติมีเดียของนักศึกษาสําหรับผูสอน 

 
รูป ค.34 เมนูขอมูลสารสนเทศ 

 
จากรูป ค.33 เมนูยอยสถิติการใชวัสดุสารสนเทศจะประกอบไปดวยเมนูสําหรับ
เลือกรายการเพื่อจัดทํารายงานดังนี ้

1) จํานวนผูใชบริการ ดังรูป ค.35 
2) จํานวนยืมวัสดุสารสนเทศแยกตามประเภทวัสดุสารสนเทศ ดัง

รูป ค.36 
3) จํานวนยืมวัสดุสารสนเทศแยกตามรายการ ดังรูป ค.37 
4) จํานวนการเขาใชโปรแกรมมัลติมีเดีย ดังรูป ค.38 
5) จํานวนการเขาใชโปรแกรมมัลติมีเดียตามกลุมเรียน ดังรูป ค.39 

 

 
รูป ค.35 รายงานจํานวนผูใชบริการเขาใชศูนยภาษา  
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รูป ค.36 ตัวอยางรายงานสถิติการใชวัสดุสารสนเทศแยกตามประเภทวสัดุสารสนเทศ 

 

 
รูป ค.37 จํานวนยืมวัสดุสารสนเทศแยกตามรายการ 
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รูป ค.38 จํานวนการเขาใชโปรแกรมมัลติมีเดีย 

รูป ค.39 จํานวนการเขาใชโปรแกรมมัลติมีเดียตามกลุมเรียน 



 
ภาคผนวก ง  

 
คูมือการใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา 

มหาวิทยาลัยราชภัฏอุตรดิตถ สําหรบัผูใชบรกิาร 
 
ระบบใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวทิยาลัยราชภัฏอุตรดิตถ ในสวน

ของผูใชบริการ พัฒนาข้ึนเพือ่ใหการเขาใชบริการโปรแกรมมัลติมีเดียมีความสะดวก เปนโปรแกรม
ท่ีสรางเมนูเพือ่ใหผูเขาใชบริการสามารถเลือกใชโปรแกรมมัลติมีเดียตามท่ีตนเองสนใจ สามารถทํา
ตามข้ันตอนดงันี้ 
 
ง.1 หนาจอหลักของการเขาใชระบบ 

5. ระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวน
ของผูใชบริการ จะทําการเปดระบบโดยอัตโนมัติหลังเปดใชงานระบบปฏิบัติวินโดวส 
ในกรณีท่ีไมสามารถเปดระบบโดยอัตโนมัติไดนั้น สามารถเปดใชงานได โดยคลิกไป
ท่ี Start > All Programs > LC Student > LC Student 2007  

6. หนาจอหลักของการเขาใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัย
ราชภัฏอุตรดิตถ ในสวนของผูใชบริการจะปรากฏดังรูป ง.1 

 
รูป ง.1 หนาจอหลักของการเขาใชระบบใหบริการวัสดสุารสนเทศของศูนยภาษา 

มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชบริการ 
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 จากรูป ง.1 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้
  หมายเลข 1 รหัสผูใชบริการ ปอนรหัสผูใชบริการเพื่อเขาสูระบบ 
  หมายเลข 2 รหัสผานผูใชบริการ ปอนรหสัผานผูใชบริการเพื่อเขาสูระบบ 

หมายเลข 3 ตกลง เพื่อยืนยนัการเขาใชงานระบบใหบริการวัสดุสารสนเทศของ
ศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชบริการ 

หมายเลข 4 Guest Login เขาใชงานระบบใหบริการวสัดสุารสนเทศของศูนยของ
ภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชบริการ โดยไมมีการบันทึกขอมูลการ
เขาใชโปรแกรม เหมาะสําหรับผูใชบริการที่ไมรหัสผูใชบริการ แตตองการเขาใชโปรแกรม
มัลติมีเดีย 

หมายเลข 5 ออกจากระบบ 
 

ง.2 หนาจอทํางานหลักของผูใชบริการท่ีลงรหัสผูใชบริการ 
 เม่ือผูใชบริการลงช่ือผูใชบริการและรหัสผานผูใชบริการถูกตอง และยืนยันการเขาใช
ระบบแลว ระบบใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ โดย
หนาจอในสวนของผูใชบริการสามารถแสดงดังรูป ง.2  
 

 
รูป ง.2 หนาจอทํางานหลักของผูใชบริการที่ลงรหัสผูใชบริการ 

 
 หนาจอทํางานหลักของผูใชบริการที่ลงรหัสผูใชบริการ ประกอบดวยเมนูการทํางานตางๆ 
ท่ีอํานวยความสะดวกและ สนับสนุนการทํางานของผูใชบริการ ดังรูป ง.3  
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รูป ง.3 เมนูการทํางานหนาจอทํางานหลักของผูใชบริการที่ลงรหัสผูใชบริการ 

 
จากรูป ง.3 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้
 รูป ง.3 หมายเลข 1 ขอมูลผูใชบริการ ประกอบดวยเมนยูอย แสดงดังรูป ง.4  

 
รูป ง.4 เมนูขอมูลผูใชบริการ 

 
  จากรูป ง.4 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

หมายเลข 1.1 Home สําหรับแสดงหนาจอแสดงขอมูลขาวสารที่แจงให
ผูใชบริการทราบ 

หมายเลข 1.2 แสดงขอมูลรายการคางสงวสัดุสารสนเทศของผูใชบริการ 
เพื่อแจงใหผูใชบริการทราบ ดัง รูป ง.5 

 

 
รูป ง.5 หนาจอแสดงรายการยืมวัสดุสารสนเทศ 

 
 



 

 

102 

 จากรูป ง.3 หมายเลข 2 โปรแกรมมัลติมีเดยี ประกอบดวยเมนยูอย แสดงดังรูป ง.6  

 
รูป ง.6 เมนูโปรแกรมมัลติมีเดีย 

จากรูป ง.6 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้
 หมายเลข 2.1 โปรแกรมท่ีผูสอนกําหนด คือโปรแกรมมัลติมีเดียท่ีอาจารย

ผูสอนไดกําหนดใหผูใชบริการเขามาศึกษา โดยมีหนาจอการทํางานแสดงดังรูป ง.7 

 
รูป ง.7 หนาจอทํางานโปรแกรมมัลติมีเดียท่ีอาจารยผูสอนไดกําหนดใหผูใชบริการเขามาศึกษา 
 

 หมายเลข 2.2 โปรแกรมท่ีใหบริการ คือโปรแกรมมัลติมีเดียท่ีศูนยภาษา
ใหบริการสําหรับผูใชบริการเขามาศึกษา โดยมีหนาจอการทํางานแสดงดังรูป ง.8 

 
รูป ง.8 หนาจอโปรแกรมมัลติมีเดียท่ีใหบริการของศูนยภาษา 
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จากรูป ง.3 หมายเลข 3 วีดีโอแนะนําศูนยภาษา เปนวีดีโอท่ีจัดทําข้ึนเพื่อแนะนําขอมูล
พื้นฐานของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถใหกับผูใชบริการ แสดงดังรูป ง.9 

 
รูป ง.9 เมนูวีดโีอแนะนําศูนยภาษาสําหรับผูใชบริการ 

จากรูป ง.3 หมายเลข 4 รายงาน แสดงขอมูลการเขาใชงานโปรแกรมมัลติมีเดียของผูเขาใช
บริการ แสดงดังรูป รูป ง.10 

 
รูป ง.10 เมนูรายงานการเขาใชโปรแกรมมัลติมีเดีย 
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จากรูป ง.3 หมายเลข 5 คูมือการใชงาน แสดงคูมือการใชงานระบบระบบใหบริการวัสดุ
สารสนเทศของศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชบริการดังรูป ง.11 

 
รูป ง.11 คูมือการใชระบบระบบใหบริการวัสดุสารสนเทศของศูนยของภาษา 

มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชบริการ 
 
 จากรูป ง.3 หมายเลข 6 ออกจากระบบ กลับไปยังหนาจอเขาสูระบบ 
 
ง.3 หนาจอทํางานหลักของผูใชบริการลงชือ่เขาใชแบบผูใชท่ัวไป (Guest Login) 

เม่ือผูใชบริการ ลงช่ือเขาใชระบบแบบผูใชท่ัวไป (Guest Login) ระบบใหบริการวัสดุ
สารสนเทศของศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ โดยหนาจอทํางานหลักของผูใชบริการ
ลงช่ือเขาใชแบบผูใชท่ัวไป (Guest Login) สามารถแสดงดังรูป ง.12 

 
รูป ง.12 หนาจอทํางานหลักของผูใชบริการลงช่ือเขาใชแบบผูใชท่ัวไป (Guest Login) 
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หนาจอทํางานหลักของผูใชบริการลงช่ือเขาใชแบบผูใชท่ัวไป (Guest Login) ประกอบ 
ดวยเมนูการทํางาน ท่ีอํานวยความสะดวกและสนับสนุนการทํางานของผูใชบริการ ดังรูป ง.13 

 

 
รูป ง.13 เมนูการทํางานหลักของผูใชบริการลงช่ือเขาใชแบบผูใชท่ัวไป (Guest Login) 

 
จากรูป ง.13 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

หมายเลข 1 Home สําหรับแสดงหนาจอแสดงขอมูลขาวสารที่แจงใหผูใชบริการ
ทราบ ดังรูป ง.14 

 

 
รูป ง.14 หนาจอแสดงขอมูลขาวสารที่แจงใหผูใชบริการ ลงช่ือเขาใชแบบผูใชท่ัวไป (Guest Login) 

 
จากรูป ง.13 หมายเลข 2 โปรแกรมท่ีใหบริการ คือโปรแกรมมัลติมีเดียท่ีศูนยภาษา

ใหบริการสําหรับผูใชบริการเขามาศึกษา โดยมีหนาจอการทํางานแสดงดังรูป ง.15 



 

 

106 

 
รูป ง.15 เมนูโปรแกรมท่ีใหบริการ 

 
จากรูป ง.13 หมายเลข 3 วีดีโอแนะนําศูนยภาษา เปนวีดีโอท่ีจัดทําข้ึนเพื่อแนะนํา

ขอมูลพื้นฐานของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถใหกับผูใชท่ัวไป แสดงดังรูป 
ง.16 
 

 
รูป ง.16 เมนูวดีีโอแนะนําศูนยภาษสําหรับผูใชท่ัวไปา 

 
จากรูป ง.13 หมายเลข 4 คูมือการใชงานแสดงดังรูป ง.17 
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รูป ง.17 เมนูคูมือการใชงานสําหรับผูใชท่ัวไป 

 
จากรูป ง.13 หมายเลข 5 ออกจากระบบ สําหรับออกจากระบบ 

 



 

ภาคผนวก จ 
 

แบบประเมนิผลความพึงพอใจ 
การใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอตุรดิตถ 

 
สําหรับนักศึกษา 

คําชี้แจง 
แบบประเมินผลนี้ เปนแบบประเมินผลเพือ่ประเมินความพึงพอใจการใชระบบใหบริการ

วัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ  กรุณาตอบแบบประเมินนี้ตามความ
เปนจริง และแสดงความคิดเห็นเพื่อประโยชนในการพัฒนาระบบตอไป   

 

โปรดขีดเคร่ืองหมาย  ลงในระดบัความพึงพอใจของนักศึกษาตอการใชระบบ 
 

ระดับความพงึพอใจ 

ลําดับ รายละเอียดการประเมิน 

มา
กที่

สุด
  

มา
ก 

ปา
นก

ลา
ง 

นอ
ย  

นอ
ยที่

สุด
 

ความสะดวกที่ไดรับจากระบบ             

1 ลดระยะเวลาในการรับบริการ      

2 มีความสะดวกในการรับบริการ      

3 มีความถูกตอง และเช่ือถือได      

4 
ตรวจสอบสิทธิ และรายการเขาใชโปรแกรม
มัลติมีเดีย 

     

 
ขอเสนอแนะในการปรับปรุงและพัฒนาโปรแกรม 
……………………………………………………………………………………………………… 
……………………………………………………………………………………………………… 
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แบบประเมินผลความพงึพอใจ 
การใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดติถ 

 
สําหรับเจาหนาท่ี 

คําชี้แจง 
แบบประเมินผลนี้ เปนแบบประเมินผลเพือ่ประเมินความพึงพอใจการใชระบบใหบริการ

วัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ  กรุณาตอบแบบประเมินนี้ตามความ
เปนจริง และแสดงความคิดเห็นเพื่อประโยชนในการพัฒนาระบบตอไป   

 
โปรดขีดเคร่ืองหมาย  ลงในระดบัความพึงพอใจของนักศึกษาตอการใชระบบ 

ระดับความพงึพอใจ 

ลําดับ รายละเอียดการประเมิน 

มา
กที่

สุด
  

มา
ก 

ปา
นก

ลา
ง 

นอ
ย  

นอ
ยที่

สุด
 

การใชงานระบบ           
1 การออกแบบหนาจอเพื่อติดตอกับผูใชงาน      

2 ความสะดวกในการใชงานบันทึกขอมูล      

3 คําอธิบายการใชงานท่ีชัดเจน      

4 การปองกันการเขาถึง (ระบบ Login)      

5 ลดระยะเวลาและมีความสะดวกในการทํางาน      

6 ลดความผิดพลาดในการจดัเก็บและรวบรวม
ขอมูลในรูปแบบเอกสาร 

     

7 การรายงานของระบบครอบคลุมตามความ
ตองการ 

     

8 มีความถูกตอง และเช่ือถือได      
 
 
 
 



 

 

110 

 

ระดับความพงึพอใจ 

ลําดับ รายละเอียดการประเมิน 

มา
กที่

สุด
  

มา
ก 

ปา
นก

ลา
ง 

นอ
ย  

นอ
ยที่

สุด
 

การใชงานระบบ           

1 หนาจอสําหรับทํารายการ      

2 ระบบล็อกอิน (Login)      

3 ระบบจัดการขอมูล      

4 ระบบออกรายงาน      

 
ขอเสนอแนะในการปรับปรุงและพัฒนาโปรแกรม 
……………………………………………………………………………………………………… 
……………………………………………………………………………………………………… 
……………………………………………………………………………………………………… 

 
ขอขอบคุณท่ีใหความรวมมือในการตอบแบบสอบถาม 

 

 



 

ประวัติผูเขียน 
 
 

ช่ือ นายสมชาย   คําวรรณะ 
 
วัน เดือน ป เกิด 19 มิถุนายน 2521 
 
ประวัติการศึกษา สําเร็จการศึกษามัธยมศึกษาตอนปลาย 

 แผนการเรียนศิลปศาสตร-คณิตศาสตร 
 โรงเรียนสา  อ.เวียงสา  จังหวัดนาน 
 ป พ.ศ. 2539 
 
 สําเร็จการศึกษาปริญญาวิทยาศาสตรบัณฑิต 

 โปรแกรมวิชาวิทยาการคอมพิวเตอร 
 สถาบันราชภัฎอุตรดิตถ   จังหวัดอุตรดิตถ 
 ป พ.ศ. 2543 
 
ประสบการณ พ.ศ. 2543 – 2544 

เจาหนาท่ีระบบคอมพิวเตอร 
 โรงพยาบาลอุตรดิตถ อําเภอเมือง จังหวัดอุตรดิตถ 
 
 พ.ศ. 2544 – ปจจุบัน 
 นักวิชาการคอมพิวเตอร 
 ศูนยภาษา  มหาวิทยาลัยราชภัฏอุตรดิตถ  
 อําเภอเมือง   จงัหวัดอุตรดิตถ 
   
 
  
 
  

 
 


